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Overview
This help file documents version 1.1 of WebEtch. 

If you do not register this software, 
the evaluation period ends December 31, 1997.

Please support the efforts of shareware developers by registering programs that you find
useful.

WebEtch provides powerful editing capabilities to help you rapidly develop quality web 
pages. 

WebEtch allows you to edit the tag level, giving you have more control over the appearance 
of the page. This helps to ensure maximum compatibility with a large number of popular 
browsers. 

If you design pages for use by more than one browser, you should test the pages to ensure 
that they display properly on all browsers. Since HTML is still evolving, there is no guarantee 
that what looks good on one browser will be sensible on another. 

The current beta copy of WebEtch is available from: http://mrcc.com/webed.html. 



Features
WebEtch has a multitude of features that empower the web author:

· Automatic tag insertion 
· Browser launching from the editor 
· Document template feature for starting a new web page 
· Easy color selection for fonts and backgrounds 
· Edit files greater than 64K 
· JavaScript® support
· Project tree view
· Automatically fills in image size when inserting a gif or jpg img src tag
· History list for urls 
· History list for images 
· Option to select upper or lower case tag style
· Guides for inserting links, images, tables, and more 
· Multiple toolbars 
· Publish feature to copy selected resources to a distribution or upload directory
· Resource listing of URLs and images referenced in your document 
· Table import from comma/quote delimited files 
· Tag highlighting with customizable colors for easier editing 
· User customizable toolbar for inserting tags and strings 
· Support for frames 
· Marquee tag support 
· Selectable editor font 
· Font and text color options for Document template 
· Support for Windows NT
· Client Side Image map template
· Support for forms 
· Popup edit menu 
· More accelerator keys for common functions 
· Ability to set a default directory for loading images and html 
· Save current working directory and restore on startup 
· Insert text or html file into current document 
· Link color options in Document|Template 



Customizing tags and strings
WebEtch allows you to define your own custom tags and strings and use them from the 
drop-down toolbar.

Custom tags are stored in a text file named utags.txt. This file can be edited with any text 
editor, or with WebEtch. Entries consist of the tag name, with no delimiters. 

When selected from the toolbar, any selected text will be enclosed within the opening and 
closing tag. 
For example, the entry

CENTER
in utags.txt will result in the following being inserted into your document:

<CENTER></CENTER>
See the contents of utags.txt for additional examples.

Custom strings are stored in a text file named ustrings.txt. This file can be edited with any 
text editor, or with WebEtch. Entries consist of the text you want added to the drop down 
toolbar (dialog bar). Enter one string per line, with no delimiters. 

When selected from the toolbar, any selected text will be replaced by the custom string.

Use this feature to store strings you insert frequently into your document, such as your 
name, copyright notices, etc.



Deleting tags
Tags can be deleted by
1. Pressing the delete tag button on the toolbar when the cursor is placed within the tag
2. Using the delete key to delete each character of the tag 
3. Pressing Ctrl-D while the cursor is anywhere in the tag.
Shortcuts

Toolbar:



Highlighting tags
Tags can be highlighted by:
1. Pressing the highlight button on the toolbar
2. At load time by specifying the highlight on open option under the Tools | Configure menu.
Shortcuts

Toolbar:



About  Displays information about WebEtch



Table ImportImporting tables into WebEtch



About WebEtch
Displays information about WebEtch, including your registration name and the version 
number.



Table
Inserts a table definition with options:
Rows: the number of rows in the table. These are defined by <TR></TR> tags. A empty set of tags will be 
inserted for each row.

Columns: the number of columns in the table. These are defined by <TD></TD> tags. An empty set of 
tags will be inserted for each column.

Border: the width of the table border. A value of 0 indicates no border will be displayed.

Width: the width of the table in pixel units or percent. If you check the In % checkbox, the table width will 
be sized to the percentage indicated in the width field.

Cellspacing: sets the spacing between cells

Cellpadding: sets the padding between the cell contents and it’s border



Table Alignment
The alignment feature allows you to insert a header, row, or cell tag with specific options:
Align: controls the horizontal alignment of the contents of the cell

Valign: controls the vertical alignment of the contents of the cell. This is useful if you want all cell contents 
to be displayed starting at the top (or bottom, etc.) of the cell and the cells are of different height due to 
their contents.



Table Caption
Inserts a caption tag, encapsulating any selected text. The caption is displayed over table and is not 
surrounded by borders.



Table header (Table menu)
Inserts a header tag, encapsulating any selected text Header are placed over a column in 
the table. 



Table Import (Table menu)
WebEtch supports importing of delimited text files. Currently only comma/quote 
delimited files are supported. This provides import of tabular data from most popular 
database and spreadsheet programs.

To import a table, select Import from the Table menu, and fill in the filename for the ascii 
file, as well as the table options you desire. WebEtch will import the data and add table tags 
accordingly. 

Note - If you have a mixture of character and numeric data in your source program, your 
import file may contain numbers with no quotes. These may not import properly.



File menu commands
New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Insert file Inserts a text or html file into the current document.
Run 
browser

Starts the default html browser and displays the current document.

Print Prints a document.
Print 
Preview

Displays the document on the screen as it would appear printed.

Print Setup Selects a printer and printer connection.
Register Registers WebEtch using your serial number and User name
Exit Exits WebEtch.



Edit menu commands
Undo Reverse previous editing operation.
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.
Paste Link Pastes from the clipboard a link to data in another application.
Delete tag Deletes the html tag under the cursor.
Strip tags Strips all html tags from the selected text.
Find Searches for text in the document.
Replace Replaces occurrences of specific text.
Uppercase Converts the current selection to uppercase.
Lowercase Converts the current selection to lowercase.
Select all Selects all text in the current document.
Wordwrap Turns wordwrap on or off.



Document menu commands
Html Inserts an html tag
Head Inserts a head tag
Title Inserts a title tag
Body Inserts a body tag.
Template Opens a property sheet that allows you to build 

a starter document.
Updated Inserts    Updated and the current date. 
Address Inserts an address tag
Project Tree view of files and URLs associated with the 

current html document.
Publish! Publish copies selected resources to a directory 

so you can upload or copy them to your web 
server.

List resources Displays a resource list of all URLs and images 
referenced in your document.

Highlight tags Highlights the html tags in your document. 
Colors for the tag types can be changed using 
the Colors dialog



Layout menu commands
Break Insert a break tag or variations thereof
Headings Insert heading tag with sizes from 1 to 6 around 

selected text or, if no selection, just inserts the 
opening and closing tags.

Horizontal rule Insert a normal horizontal rule
Extended 
horizontal rule

Customize the insertion of a horizontal rule to 
include width, height, shading, etc.

Paragraph Insert a paragraph tag
Descriptive list tag Inserts the descriptive list <DL> tag around 

selected text or, if no selection, just inserts the 
opening and closing tags.

Descriptive list title Inserts the descriptive list title tag <DT>
Descriptive list 
description

Inserts the descriptive list description tag <DD>

List element Inserts the list tag <LI>
Ordered list Creates an ordered list
Unordered list Creates an unordered list
Blockquote Insert blockquote tag
Comment Inserts a comment
Marquee Inserts a marquee tag
Client-side image 
map

Inserts a client-side image map template



Format menu commands
If the formatting commands are invoked while text is selected, the text is encapsulated 
between the tags.

Bold Inserts bold tag: <B></B>
Italic Inserts italics tag: <I></I>
Preformatted Inserts preformatted text tag: <pre></pre>.
Strong Inserts strong tag: (<STRONG></STRONG>). Similar 

to bold.
Emphasis Inserts emphasis tag: (<EMPHASIS></EMPHASIS>). 

Similar to italics.
Small Inserts small tag: (<SMALL></SMALL>)
Superscript Inserts superscript tag: (<SUP></SUP> )
Subscript Inserts subscript tag: (<SUB></SUB>)
Fixed width Inserts fixed width tag: (<TT></TT>)
Center Inserts center tag: (<CENTER></CENTER>)
Base font 
size

Selects the default font size (normally assumed to be 
3)

Selection Formats the current selection
Entities Inserts special character codes



Links menu commands
Image Inserts an image link
Mailto Inserts a mailto link with email address
URL Inserts a link to a URL (both href and anchors)



Forms menu commands
Form Inserts a form tag
Input Inserts an input field for    a form
Textarea Inserts a text area to accept user input or display data
Select Inserts a drop down list of selections



Frames menu commands
1X2 Inserts a 1 row X 2 column frame definition
2x2 Inserts a 2 row X 2 column frame definition
3x2 Inserts a 3 row X 2 column frame definition

Options menu commands
Colors Sets tag highlighting colors
Preferences Customizes the way WebEtch works



Table menu commands
Table Inserts table tags with options
Alignment Sets alignment for table headers, rows, and cells
Caption Inserts caption tags for a table
Header Inserts header tags
Row Inserts a row tag
Cell Inserts a cell (data) tag
Import Imports a table from a comma delimited text file



Tools menu commands
JavaScript Inserts JavaScript widgets into your document



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbars.
DialogBar Shows or hides the dialog bar containing the font, heading,

string, and tag drop down boxes
StatusBar Shows or hides the status bar.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 
2, ...

Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help 
Topics

Offers you an index to topics on which you can get help.

Tip of the
Day 

Shows the Tip of the Day dialog

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in WebEtch. You can open an existing 
document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple 
documents at once.    Use the Window menu to switch among the multiple open documents.  
See Window 1, 2, ... command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:

Html (.html, .htm, etc)
Text (.txt)

Drives
Select the drive in which WebEtch stores the file that you want to open. 

Directories
Select the directory in which WebEtch stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    WebEtch suggests 
that you save changes to your document before you close it.    If you close a document 
without saving, you lose all changes made since the last time you saved it.    Before closing 
an untitled document, WebEtch displays the Save As dialog box and suggests that you name
and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, WebEtch displays the Save As dialog box so you can 
name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    WebEtch displays the Save As 
dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name. WebEtch adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Run browser
Causes WebEtch to launch the application (browser) associated with the file type of the 
current document. If your browser is Netscape    or Internet Explorer and it is already 
running, this menu item initiates a DDE conversation with the browser and instructs it to 
load the current document.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your WebEtch session.    You can also use the Close command on 
the application Control menu.    WebEtch prompts you to save documents with unsaved 
changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.      The name of the 
command changes, depending on what the last action was.    The Undo command changes to
Can't Undo on the menu if you cannot reverse your last action.

Shortcuts
Toolbar:

Keys: CTRL+Z or
ALT-BACKSPACE



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Strip Tags (Edit menu)
Removes all html tags (or anything enclosed in <>) from the current selection. This 
command is useful for removing formatting from large blocks of text.



Uppercase (Edit menu)
Convert all selected text to uppercase. Tags and normal text are both converted.



Lowercase (Edit menu)
Convert all selected text to lowercase. Tags and normal text are both converted.



Select all (Edit menu)
Selects all text in the document.



Wordwrap (Edit menu)
Toggles wordwrap on and off. Default behavior for this feature can be set in Options | 
Preferences



Html (Document menu) <html></html>

Inserts the html tag around selected text or, 
if no selection, just inserts the opening and closing tags.



Head (Document menu) <head></head>

Inserts a head tag around selected text or, 
if no selection, just inserts the opening and closing tags



Title (Document menu) <title></title>

Inserts the title tag around selected text or, 
if no selection, just inserts the opening and closing tags



Body (Document menu) <body></body>

Inserts the body tag around selected text or, 
if no selection, just inserts the opening and closing tags.



Document Template
Use the document template to insert tags for a new html document. Normally the template is used on a 
blank document.

Definitions:
General
Title

The title for the page. This is normally displayed in the caption bar of your browser’s main window.
Page heading

Main heading for the page. This is placed at the top of the document.
Color/Texture
Link

Color for links
Visited Link

Color for links that have already been visited
Active Link

Color for the currently active link
Texture

Name of the image file to use as the background texture
Color

Background color
Text Color

Default text color
Formatting
Center Heading

Centers the page heading
Include horizontal rules

Adds horizontal rules at the top of the page below the heading, and at the bottom of the page above the
address line.
Heading Size

Font size for the heading
Address

Address information of the author, webmaster, etc.
Make address a mailto: link

Makes the address specified above a mailto: link
Insert date updated

Inserts the current date into the document. Example: Updated 5/25/97
Text
Text for body of page

Text (and tags if desired) that appear in the body of the page. Additional text and tags can be added to 
the page after the template has been inserted.



Updated (Document menu)

Inserts the word Updated and the current date. You can also use a JavaScript widget to date 
your pages



Address (Document menu)

Inserts an address tag around selected text or, 
if no selection, just inserts the opening and closing tags



.Project (Document menu)
Project gives you a tree view of the files associated with the current html document.

For local files, file information including pathname, dates accessed, created, and modified, and file size. 

URLs are indicated as Internet Resources.



Publish! (Document menu)
Publish copies selected resources to a directory so you can upload or copy them to your web server. 
Although Publish lists all the local resources in your document, it will only copy those you highlight.

To copy resources, highlight the URLs and Images you want to publish and click the Copy button. 
WebEtch will inform you how many URLs and Images were successfully copied to the publish directory.



List Resources (Document menu)
Displays a resource list of all URLs and images referenced in your document. This includes both local and
Internet resources. 

If you have open quotes in your URLs, WebEtch will warn that it was not able to resolve all your 
resources and some are not displayed. To prevent this warning, make sure all resources are properly 
quoted.

Example: <A HREF="http://mrcc.com/webed.html">WebEtch Home Page </A>
Note the HREF is enclosed in double quotes



Highlight tags (Document menu)
Highlights the html tags in you current document. 



Break (Layout menu) <br>
Normal break inserts a break <BR> tag. You can insert a break tag from the toolbar or from 
the keyboard by using Ctrl+Enter.

The break clear left, clear right, and clear all options insert tags that are used with floating 
images. The clear left and clear right tags will break vertically until there is a clear left or 
right margin. 

In the case of the clear all tag, it inserts a vertical break that provides clear left and right 
margins.
Shortcuts

Key Ctrl+Enter (normal Break)
Toolbar



Headings (Layout menu)
Inserts heading tags with sizes from 1 to 6. The tags are placed around any selected text. 

Shortcuts
Keys Alt+1 through Alt+6



Horizontal rule (Layout menu) <hr>
Inserts the tag for a standard horizontal rule (line). 

Shortcuts
Key Ctrl-U
Toolbar



Extended Horizontal rule (Layout menu) <hr …>
Inserts customized horizontal rule tag into your document.
Options:
Width    

the width of the rule in pixels, or in percent if the percent checkbox is marked.
In Percent

indicates that the rule width is specified in percent rather than pixels
Size

the height of the rule in pixels
Align

alignment of the rule
No shading

the rule will not have a 3d shading effect applied to it.

*This tag is not supported by all browsers.



Paragraph (Layout menu) <p>

Inserts a paragraph tag in the document. This is equivalent to inserting two break tags. 

Shortcuts
Key Alt+Enter
Toolbar



Lists
WebEtch support three types of lists:

· Descriptive
· Ordered (numbered)
· Unordered



Descriptive List (Layout menu)
Descriptive lists allow you to format a title and description for text.

To create a descriptive list, insert the descriptive list tag <DL></DL> and place your entries 
as follows:

<DL>
<DT>Reindeer
<DD>Domesticated deer found in northern latitudes 
<DT>Moose
<DD>A really big deer like critter
<DT>Mouse
<DD>Everybody knows what this is...
</DL>

When rendered by the browser, the list looks like this:

Reindeer 
            Domesticated caribout found in northern latitudes 
Moose 
            A really big deer-like critter 
Mouse 
            Everybody knows what this is...

Shortcuts
Toolbar:
List tag
List title
List description



List element (Layout menu) <li>
Inserts a list element tag used with ordered (numbered) and unordered list.

Shortcuts
Key: Ctrl+L
Toolbar:



Ordered (numbered) list (Layout menu) <ol></ol>
Ordered lists are numbered lists of items. You can nest ordered (and unordered) lists to 
create sub-lists: 
You can insert the tags individually, or highlight the text you want to become an ordered list 
and choose ordered list from the menu, popup menu, or toolbar.

Example:
1. Dogs
2. Boxer
3. Beagle
4. Shih-tzu
5. Retriever

1. Golden
2. Labrador
3. Chesapeake

6. Mutt

Shortcuts:
Popup menu
Toolbar:



Unordered list (Layout menu) <ul></ul>
An unordered lists is a list of items with a bullet in front of each item. Unordered lists can be 
nested similar to ordered lists.

You can insert the tags individually, or highlight the text you want to become an unordered 
list and choose Unordered list from the menu, popup menu, or toolbar.

Shortcuts:
Popup menu
Toolbar:



Blockquote (Layout menu) <blockquote></blockquote>
Inserts blockquote tags. If text is selected, it is surrounded by the blockquote tags.



Comment (Layout menu) <!--    -->
Inserts comment tags. If text is selected, it is surrounded by the comment tags.

Shortcuts:
Popup menu



Marquee (Layout menu) <marquee … > </marquee>
Implements a scrolling message.
Definitions 
Text to scroll

Enter the message you want to scroll
Align

Alignment of the marquee
Loop

Optional parameter indicating how many times to loop through the marquee
Behavior

Defines how the marquee is displayed: slide in, scroll, or alternate back and forth.
Direction

Determines the direction of scrolling.
Background color

Sets the background color for the marquee
Height

Height of the marquee. Value is in pixels unless the “In %” box is checked.
Width

Width of the marquee. Value is in pixels unless the “In %” box is checked
Scroll amount

Number of pixels to scroll at once
Scroll delay

Delay between each scroll step
Hspace

Sets left and right margins for the outside of the marquee.
Vspace

Sets top and bottom margins for the outside of the marquee.

NOTE: Marquees are not supported by all browsers.



Client-side Image Map (layout menu) <map …></map>
Inserts tags for a client-side image map into your document. You must edit the COORDS definition after 
the tags are inserted to actually map the image to your URLs. 
Definitions
URL list

List of URLs that will be referenced in this image map.
Map Name

A name for this image map. This is used when declaring the image map. This is not the name of your 
image file.
Shape of Regions

Select the shape of regions you will be using to define hot-spots on the image map. WebEtch allows 
you to select only one shape, although you can edit the inserted tags to make adjustments as needed.
Image file

Name of the image (gif or jpg) for the map.

Example
Client-side image maps are supported by the most popular browsers.



Preformatted (Format menu) <pre></pre>
Inserts preformatted tags, encapsulating any selected text. 

Use the preformatted tag to maintain the formatting of text. The text will be rendered 
exactly as it appears, with spacing and tabs intact.



Toolbar command (View menu)

Use this command to display and hide the Toolbars, which include buttons for some of the 
most common commands in WebEtch, such as File Open.    A check mark appears next to the
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Dialog Bar (View menu)
Toggles display of the dialog bar which is located below the toolbars.



Toolbar (View menu)
The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in WebEtch,

To find out what a button does, hold the mouse cursor over it and a toolbar tip will pop up 
describing the button’s function.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the WebEtch window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You
can open multiple document windows to display different parts or views of a document at 
the same time.    If you change the contents in one window, all other windows containing the 
same document reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window menu)

WebEtch displays a list of currently open document windows at the bottom of the Window 
menu.    A check mark appears in front of the document name of the active window.    Choose
a document from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using WebEtch and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
WebEtch.



Context Help command 

Use the Context Help command to obtain help on some portion of WebEtch.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the WebEtch window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the WebEtch window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    WebEtch determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    WebEtch determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the html window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item 
changes to Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Modifying the Document
To construct an HTML document, enter text surrounded by HTML tags. WebEtch makes it 
easy to add tags using the menus, toolbars, or the popup menu (right mouse button).

To start a new document, you can use the Document | Template menu to specify the basic 
page layout.





No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Whats new in Version 1.1

These are some of the features in this version:

History list for urls 
History list for images 
Option to select upper or lower case tag style 
Highlight following save option 
Highlight progress bar added 
Automatically fill in image size when inserting a gif or jpg img src tag 
Table generator 
Window caption optionally shows full path of current document 
Basic frames generator 
Project tree view
Miscellaneous bug fixes



Registering WebEtch

This program is distributed as shareware.    You are free to evaluate it, copy, and share it with others.    If 
you find the program useful and continue to use it, please register it.    (See License & Warranty or the file 
license.txt for further information). 

When you register, you will receive information on how to activate your registration. It is important that you
include your email address when you register so we can send you your activation information 
immediately.

To register, enclose a check or money order for $20 and mail to:
Micro Resources
PO Box 671222
Chugiak, AK    99567-1222
Phone/Fax (907) 688-0161
E-mail: sherman@mrcc.com
http://mrcc.com/webed.html

Be sure to include your name, address, phone number, and e-mail address.

You can also register WebEtch Version 1.1 via Compuserve. On Compuserve, GO SWREG and select 
registration ID 12638.



License & Warranty Disclaimer

You should carefully read the terms and conditions associated with this program prior to its use.

You are hereby licensed to use WebEtch for a 30 day evaluation period.    You may make as many copies 
of the program as you wish, provided that each "copy" contains the entire contents of the distribution file.

Evaluation and Registration 
This is not free software.    This license allows you to use this software for evaluation purposes without 
charge for a period of 30 days.    If you use this software after the 30 day evaluation period, a registration 
fee of $20 is required.

Disclaimer of Warranty

This software and the accompanying files are provided "as is". without any warranty as to performance or 
suitability, or any other warranties expressed or implied.

As with all new software, this program should be thoroughly tested with non-critical data and/or in non-
critical applications before relying on it.    The user must assume all risk associated with use of this 
program.    Any liability on the part of the seller will be limited exclusively to product replacement or refund 
of the purchase price.





Form tag (Forms menu)
Insert the form tag, method, and URL. This is the definition of a form and the action to be taken when the 
user submits the form. Form elements such as input fields, select fields, and text areas.
Definitions:
Action

The URL that receives the form information. For example, the URL may be a cgi script or program or a 
mailto: link.
Method

The method used to submit the information. 



Form Input (Forms menu)
The input field of a form collects information from the user. There are many types of input widgets as 
described below
Definitions:
Descriptive text

This is the label or description of the input field that will be displayed on the form.
Name 

a identifying name for the field
Type

type of input field: Checkbox, Hidden, Password, Radio, Reset, Submt, Text
Default value

value that is initially displayed on the form
Size

visible width of the field.
Max length

the maximum number of characters the users can enter into this field.
Checked by default

for checkboxes or radio buttons, indicates that they are initially checked when the form is displayed.



Form Text Area (Forms menu)
Insert an area where the user can enter free form text.
Definitions:
Default text

Default text displayed when the form is initially displayed.
Name

name for the text area field.
Rows

number of rows to display
Columns

number of columns to display



Form Select (Forms menu) 
Inserts a drop down list of selections from which the user can choose one or more items.
Definitions:
Name

name for the text area field.
Number of selections visible

controls how many selections are displayed in the control.
Allow multiple selections

if checked the user can make multiple selections from the control.
Selections

list of selections to be displayed in the control.



Format Selection (Format menu)
Formats the selected text, using the following options:
· Bold
· Center
· Italic
· Preformatted
· Superscript
· Subscript
· Font color 
· Font size
Use this option to apply multiple formatting tags to a selection. For example, if you want to make bold 
italic red text, you can do it in one operation using format selection.
Shortcuts:

Popup menu



Frames
WebEtch provides basic frame support by allowing you to choose from three frame styles:

Two column (1X2)

Two rows, two columns (2X2)

Three rows, two columns (3X2)

Frame dimensions can be expressed in either pixels or percent. WebEtch uses percent values to define 
the frames. These can be adjusted if necessary once the frame tags are inserted into the document.

NOTE: Frames are not supported by all browsers.



Frames - 1X2

 This layout consists of two columns. The default widths are 25% for the left column and 75% for the right.
You set the value for the left column only and WebEtch calculates the width of the right.
Definitions
Column 1 width

width of column 1 in percent.
URLs - Left and Right frame

These are the URLs that are displayed in the left and right frame respectively.
Window Names

Each frame can be given a window name that can be used as a target for loading subsequent html files.
This is an optional parameter.
Scrolling

Controls scrolling behavior for each frame.
Resizing

Enables or disables resizing of the frame. If checked, the user will not be able to change the frame 
dimensions.



Frames - 2X2

 This layout consists of two rows and two columns. The default row heights are 25% for the top and 75% 
for the bottom. Column widths are 25% for the left column and 75% for the right. You set the value for the 
top row and left column only and WebEtch calculates the others.
Definitions
Column 1 width

width of column 1 in percent. 
Row 1 height

height of row 1 in percent.

URLs - Top, Left, and Right frame
These are the URLs that are displayed in the top, left, and right frame respectively.

Window Names
Each frame can be given a window name that can be used as a target for loading subsequent html files.

This is an optional parameter.
Scrolling

Controls scrolling behavior for each frame.
Resizing

Enables or disables resizing of the frame. If checked, the user will not be able to change the frame 
dimensions.



Frames - 3X2

 This layout consists of three rows and two columns. The default row heights are 25% for the top, 50% for
the middle, and 25% for the bottom. Column widths are 25% for the left column and 75% for the right. You
set the value for the top and middle rows and left column only and WebEtch calculates the others.
Definitions
Column 1 width

width of column 1 in percent. 
Row 1 height

height of row 1 in percent.
Row 2 height

height of row 2 in percent.
URLs - Top, Left, Right, and Bottom frame

These are the URLs that are displayed in the top, left, right, and bottom frame respectively.
Window Names

Each frame can be given a window name that can be used as a target for loading subsequent html files.
This is an optional parameter.
Scrolling

Controls scrolling behavior for each frame.
Resizing

Enables or disables resizing of the frame. If checked, the user will not be able to change the frame 
dimensions.



Set highlight colors (Options menu)
You can customize the colors WebEtch uses for highlighting tags. 

Choose the tag type or group from the drop down list and then click on the Set button to change the color.

These settings are stored in your webetch.ini file.



Image link (Links menu)
Inserts a link to an image into your document.
Definitions
Image source

Specifies the name of the image file and the relative path. You can use the Browse button to navigate 
your system and select the file.
Width

Width of the image in pixels
Height

Height of the image in pixels
Alignment

Defines the alignment for the image
Border

Specifies the width of the border surrounding the image
Vspace

Controls the vertical space above and below the image. This can be used to provide spacing between 
the image and adjacent text.
Hspace

Controls the horizontal space on the left and right of the image. This can be used to provide spacing 
between the image and adjacent text.
Alt

Name displayed if the image is not loaded by the users browser.
No Border

If checked, specifies that no border will be displayed around the image when it is included in an HREF 
link.

Shortcuts:

Toolbar 



Insert text file (File menu)
Inserts a text file into the current document. The file can be any ASCII text, including html.
Definitions
File name

Name of the file to insert. You can use the Browse button to locate and select the file.
Use PREformat tag

If checked, the contents of the file will be surrounded by the <PRE> tag when inserted. This will 
preserve the original format of the file, including line returns and spacing.



JavaScript Support
WebEtch contains an assortment of JavaScript scripts that can enhance your web page:

Alert:Pops up an alert message when a button is pushed. 

Page dating:    Inserts a script that displays the last modified date and time each time a document is 
loaded.

Create window    Inserts a script to create a new browser window.

Open window button  Inserts a button to be used in conjunction with the Create window script.

Email Button:  Used to create an Email button.



JavaScript - Alert
Pops up a dialog with an alert message and an OK button. 

To create an alert, enter the title (text) for the button and the message. 

If you are inserting a stand alone alert, you should check the Include <FORM> tags checkbox. 

If you are adding the alert to an existing form, the <FORM> tags should be ommitted.



JavaScript - Page dating
This script will provide automatic dating for your page revisions. Insert the script into the document where 
you want the date to appear on the page.

Example:
<SCRIPT LANGUAGE="JAVASCRIPT">
<!-- HIDE SCRIPT FROM INCOMPATIBLE BROWSERS
document.write("Updated: ", document.lastModified)
// END SCRIPT HIDING -->
</SCRIPT>



JavaScript - Button/Email widget
Email button:
This script is similar to a mailto link. When the user presses the button, the default mailto message 
composer for the browser is invoked and the user can send a message.

Enter the button title (eg. Email me!) and the destination email address the message.

If this button is to be part of an existing form, do not insert the <FORM> tags.

Open window button:
Enter the button title and the name of the open window function (see Create window). The name of the 
function must match that used in the Create window script.

If this button is to be part of an existing form, do not insert the <FORM> tags.



JavaScript - Create window
This function can be used in conjunction with the Open window button script to display a specific URL 
when a button is pressed.

This script should be placed in the HEAD section of your document.

URL to open: this is the URL that will be opened in the new window.

Name for window open function: This is the name for the function that will open the new window. 
OpenWindow is a good choice.

Width: Width of the new browser window

Height: Height of the new browser window

Options: The checkboxes control the appearance and functionality of the new window. These are browser
dependent—experiment to get the results you want.



URL link (Links menu)
Inserts a link or anchor to a local or Internet resource.
Definitions
URL

The URL for the link. 
Link text

The text to be displayed for the link.
URL Prefix

Prefix the URL with either http://, ftp://, or nothing.
URL Type

Specifies whether this URL is a link or an anchor.
Target window

Specifies the name of the window in which to display the URL. This is used only with frames.
Status bar comment

A comment to be displayed in the status bar of the browser when the user moves the mouse over the 
link. This is implemented using JavaScript and therefore is not compatible with all browsers.

Shortcuts:
Popup menu

Toolbar 



Mailto link (Links menu)
Creates a mailto: link that invokes the browser’s new message function. 
Definitions
E-mail Address

Internet email address that will be placed in the mail message’s To field.
Link text

Text that will appear in the link. This can be the same as the email address.

By default, any selected text is pasted into both the address and link text field.

Shortcuts:

Toolbar 





Preferences
Set user preferences. These settings are stored in your webetch.ini file.
Definitions
Path to browser

WebEtch uses this to launch your browser only if you don’t have a browser associated with html files. 
Normally WebEtch will use the default browser installed on your system and you will not need to fill out 
this field.
File options at startup

This controls the startup behavior with respect to files. The options are self-explanatory. If you choose 
Open last edited document and WebEtch can’t find it at startup, a new document will be opened instead.
Directory options

WebEtch will remember the last directory you used, or always use one that you specify. If you choose 
none, the default directory at startup will be the WebEtch application directory.
Editor font

Allows you to customize the font used in WebEtch.
Highlight tags on open

If selected, the tags in the document will be automatically highlighted when the document is opened.
Highlight tags on save

If selected, highlighting will be applied to the document after each save.
Maximize view on open

If selected, when opened the document view will be maximized to the size of the WebEtch application 
window.
Wordwrap on by default

If selected, wordwrap will be on when the document is opened.
Pathname in window caption

Puts the full pathname of the current document in the window caption.
Use uppercase tags

WebEtch uses lower case tags by default. Checking this will cause all tags inserted by the program to 
be upper case.



Client-side Image Map Example
WebEtch inserts the following tags for a client-side image map:

<MAP NAME=mymap>
<AREA SHAPE="RECT" COORDS="" HREF="url1.html">
<AREA SHAPE="RECT" COORDS="" HREF="url2.html">
</MAP>
<IMG SRC="myimage.gif" USEMAP="#mymap">

To map the hotspots for the image map, enter the coordinates for each URL. In this case the shape is a 
rectangle, so only four coordinates are needed. The completed image map might look like this:
<MAP NAME=mymap>
<AREA SHAPE="RECT" COORDS="0,0 54,40" HREF="url1.html">
<AREA SHAPE="RECT" COORDS="55,0, 118,40" HREF="url2.html">
</MAP>
<IMG SRC="myimage.gif" USEMAP="#mymap">

Additional text or html tags can be placed between the </map> tag and the <img … usemap=…> tag.







Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>





Paste Link command (Edit menu)

<< Write a topic here that talks about the kinds of objects you expect users to embed in 
your application's documents. >>



Links command (Edit menu)

Use this command to display a    Links dialog box which lets you edit links between your 
document and other documents.

This command is unavailable if you have no links in your document.



Links dialog box

<< Write a topic here that discusses the Links dialog box. >>



Object verb (Edit menu) 

<< Write a topic here that discusses Object verb. >>

Shortcut
Mouse: Double-click the object with the left mouse button.



Insert New Object command (Edit menu)

Inserts and embeds an object, such as a chart or an equation in a document. The application
in which the object was created becomes active on the screen.

Select the object you want to insert into your document using the Insert New Object dialog 
box.



Insert New Object dialog box

<< Write a topic here that discusses the Insert New Object dialog box. >>



Change Icon dialog box

<< Write a topic here that discusses the Change Icon dialog box. >>



Convert dialog box

<< Write a topic here that discusses the Convert dialog box. >>



Paste Special dialog box

<< Write a topic here that discusses the Paste Special dialog box. >>

                                                                      
 




